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MITSUBISHI Electric Corporation 

MELSERVO MR-J2 Series 

MELSERVO J2 Series Driver 
 Supported version TOP Design Studio V1.0 or higher  

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the “TOP and 

external device”. 

 

 

 

1. System configuration Page 2 

 

 

Describes the devices required for connection, the setting of 

each device, cables, and configurable systems. 

2. External device selection  Page 3 

 Select a TOP model and an external device. 

3. TOP communication setting Page 4 

 Describes how to set the TOP communication. 

4. External device setting Page 10 

 Describes how to set up communication for external devices. 

5. Cable table Page 11 

 Describes the cable specifications required for connection. 

6. Supported addresses Page 12 

 Refer to this section to check the addresses which can 

communicate with an external device. 
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1. System configuration 

The system configuration of TOP and “MITSUBISHI Electric Corporation - MELSERVO MR–J2 Series” is as follows. 

 

Series CPU Link I/F 
Communication 

method 

Communication 

setting 
Cable 

MELSERVO 

MR–J2–Super 

MR–J2S–□A  

MR–J2S–□CP  

MR–J2S–□CL 

CN3 Port 

on CPU unit 

RS–232C 

3. TOP 

communication 

setting 

4. External device 

setting 

5. Cable table 

RS–422 

MELSERVO 

MR–J2M 

MR–J2M–P8 

MR–J2M–□DU 

CN3 Port 

on CPU unit 

RS–232C 

RS–422 

“I/F module” or 

“Drive module” 

RS–232C 

RS–422 

 

 

■ Connection configuration 
 

ㆍ1:1 (one TOP and one external device) connection – configuration which is possible in RS232C/422/485 communication. 

 
 

ㆍ1:N (one TOP and multiple external devices) connection – configuration which is possible in RS422/485 communication. 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 

 
 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Please select “MITSUBISHI Electric Corporation”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

MELSERVO J2 Series Computer Link Computer Link 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project properties > TOP settings] → [Project option > Check “Use HMI settings” > Edit > Serial ] 

– Set the TOP communication interface in TOP Design Studio. 
 

 
 

 
 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-422 

RS-232C 

RS-422 
 

Baud Rate 38400  

Data Bit 8  

Stop Bit 1  

Parity Bit Even  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [ Project > Project properties > PLC settings > COM > “PLC1 : MELSERVO J2 Series”] 

– Set the options of communication driver of MELSERVO J2 Series in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “Computer Link”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device and 

sending the next command request. 
 

Retry Set the number of request retries when the data request result is no 

response/negative response. 
 

Station Num Set the prefix of an external device.  

Decimal Point of 

POS 

Configures the transfer length arrangement of the external device. Must be 

configured identically to the settings of the external device in order for normal 

writing procedure to occur on the POS address.  

*Note) 

*Note) The POS address is not supported by the driver of the J1 series.
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen.  

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Serial ] 
 

 

Items TOP External device Remarks 

Signal Level (port) RS-232C RS-422 RS-232C / RS-422  

Baud Rate 38400  

Data Bit 8  

Stop Bit 1  

Parity Bit Even  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 

 

 

 

 

 

 



 

 External device connection manual for TOP Design Studio 7 / 12 

 (2) Communication option setting 

■ [ Main screen > Control panel > PLC ] 
 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “Computer Link”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device and 

sending the next command request. 
 

Retry Set the number of request retries when the data request result is no 

response/negative response. 
 

Station Num Set the prefix of an external device.  

Decimal Point of 

POS 

Configures the transfer length arrangement of the external device. Must be 

configured identically to the settings of the external device in order for normal 

writing procedure to occur on the POS address.  

*Note 1) 

*Note 1) The POS address is not supported by the driver of the J1 series. 
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check whether the port (COM1/COM2) settings you want to use are the same as those of the external device in [Control Panel > 

Serial]. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 

ㆍThe serial communication parameters of “MELSERVO MR–J2 Series” are set with the “push button switch” on the control panel of 

the servo amplifier.  

  

ㆍReboot the external device after configuration.  

 

For a more detailed setting method than described in this example,  

refer to the user manual of the external device. 

 

■ Communication parameter setting of MELSERVO–J2–Super Series 

Items Parameter Descriptions 

Transmission length 

scale setting  

Default parameter No. 1 

: 0020 

Configure the 4-digit value of the default parameter for No. 1 as shown below: 

 

 

 
 

Prefix number setting Default parameter No. 15 0 (Default value: 0) 

Select the serial 

communication 

speed. 

Default parameter No. 16 

: 2100 

Configure the 4-digit value of the default parameter for No. 16 as shown 

below: 

 
 

① Select Serial 

Transmission Speed 

② Select serial I/F ③ Select response 

delay time 

0 9 00 BPS 0 RS–232C 0 Null 

1 19200 BPS 1 RS–422 1 Valid 

2 38400 BPS     

3 57600 BPS     
 

 

Select function 8 For MR-J2S-A: 

Extension parameter 2 

No. 53 

For MR-J2S-CP: 

Extension parameter 2 

No. 57 

Configure the 4-digit value of the default parameter for No. 53/57 as shown 

below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Push button 

switch 

①Transmission length scale 

0 1 time Number of decimal places 3 

1 10 times Number of decimal places 2 

2 100 times Number of decimal places 1 

3 1000 times Number of decimal places 0 

 

① Select the station number of the protocol 

0 There is a station number. 

1 No station number 
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■ Communication parameter setting of MELSERVO–J2–M Series 

Items Parameter Descriptions 

Select the serial 

communication 

speed. 

Default IFU parameter 

No. 0 

: 2000 

Configure the 4-digit value of the default parameter for No. 16 as shown 

below: 

 
 

① Select Serial 

Transmission Speed 

② Select serial I/F ② Select response 

delay time 

0 9600 BPS 0 RS–232C 0 Null 

1 19200 BPS 1 RS–422 1 Valid 

2 38400 BPS     

3 57600 BPS     
 

 

Interface module 

station number 

Default IFU parameter 

No. 10 

0 – 31 (Default value: 0) 

1st slot station 

number 

Default IFU parameter 

No. 11 

0 – 31 (Default value: 1) 

2nd slot station 

number 

Default IFU parameter 

No. 12 

0 – 31 (Default value: 2) 

3rd slot station 

number 

Default IFU parameter 

No. 13 

0 – 31 (Default value: 3) 

4th slot station 

number 

Default IFU parameter 

No. 14 

0 – 31 (Default value: 4) 

5th slot station 

number 

Default IFU parameter 

No. 15 

0 – 31 (Default value: 5) 

6th slot station 

number 

Default IFU parameter 

No. 16 

0 – 31 (Default value: 6) 

7th slot station 

number 

Default IFU parameter 

No. 17 

0 – 31 (Default value: 7) 

8th slot station 

number 

Default IFU parameter 

No. 18 

0 – 31 (Default value: 8) 
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5. Cable table  

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “MITSUBISHI Electric Corporation”) 
 

■ RS-232C (1:1 connection) 

COM 

Cable connection 

MELSERVO MR–J2 Series 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1    

Servo amplifier 

CN3 

(20 PIN) 

RD 2 12 SD 

SD 3 2 RD 

DTR 4 1 LG 

SG 5 11 LG 

DSR 6   

RTS 7   

CTS 8   

 9   

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

COM 

Cable connection 

MELSERVO MR–J2 Series 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  9 SDA 

Servo amplifier 

CN3 

(20 PIN) 

 2 19 SDB 

 3 5 RDA 

RDB 4 15 RDB 

SG 5 1 LG 

SDA 6 11 LG 

 7   

 8   

SDB 9   

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:N connection) – Refer to 1:1 connection to connect in the following way. 

TOP Cable connection and signal 

direction 

MELSERVO  Cable connection and signal 

direction 

MELSERVO 

Signal name Signal name Signal name 

RDA  9 SDA  9 SDA 

RDB 19 SDB 19 SDB 

SDA 5 RDA 5 RDA 

SDB 15 RDB 15 RDB 

SG 10 TRE 10 TRE 

 1 LG 1 LG 

  11 LG  11 LG 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

Device 
Word Address (The address is hexadecimal.) 

Remarks Command 
Read able Write able 

Status Status display data STS 80 – STS 91 ––––– *Note 1) 01 – 

Alarm History Alarm No. AMH 10 – AMH 16 –––––  

33  
 Alarm time AMH 20 – AMH 26 –––––  

Alarm Present Current alarm AMP 00 –––––  02 – 

Alarm Status Alarm status display AMS 80 – AMS 90 ––––– *Note 1) 35 – 

Status Clear Clear the status display data ––––– STSC 00  – 81 

Alarm Clear Clear the current alarm ––––– AMC 00  

– 82 
 Clear the alarm history ––––– AMC 20  

Inhibit/release input/output signal ––––– EIXX 00  /  EIXX 03 

EIXX 10  /  EIXX 13 

 

– 90 

Operation mode ––––– MODE 00  – 8B 

Data for test operation mode  TEST 00  /  TEST A0  – 92 

TEST 10  /  TEST 11 

TEST 20  /  TEST 21 

TEST 40  /  TEST 41 

 

- A0 

External 

input/output 

Input device status EXIN 00 ––––– 

*Note 2) 12 92 

Input pin status EXIN 40 ––––– 

 Input device ON/OFF EXIN 60 EXIN 60 

 Output device status EXIN 80 ––––– 

 Output pin status EXIN C0 ––––– 

Parameter group PRMG 01 PRMG 01  04 85 

Write parameters (EEPROM) PRAM 00 – PRAM FF PRAM 00 – PRAM 5A  
05 84 

Write parameters (RAM) PRMR 00 – PRMR FF PRMR 00 – PRMR 5A  

Write point table position data (EEPROM) PTB1 01 – PTB1 FF PTB1 01 – PTB1 FF  
40 C0 

Write point table position data (RAM) PT1R 01 – PT1R FF PT1R 01 – PT1R FF  

Write point table speed data (EEPROM) PTB2 01 – PTB2 FF PTB2 01 – PTB2 FF  
50 C6 

Write point table speed data (RAM) PT2R 01 – PT2R FF PT2R 01 – PT2R FF  

Write point table acceleration time constant 

(EEPROM) 

PTB3 01 – PTB3 FF PTB3 01 – PTB3 FF  

54 C7 

Write point table acceleration time constant (RAM) PT3R 01 – PT3R FF PT3R 01 – PT3R FF  

Write point table deceleration time constant 

(EEPROM) 

PTB4 01 – PTB4 FF PTB4 01 – PTB4 FF  

58 C8 

Write point table deceleration time constant (RAM) PT4R 01 – PT4R FF PT4R 01 – PT4R FF  

Write point table dwell time (EEPROM) PTB5 01 – PTB5 FF PTB5 01 – PTB5 FF  
60 CA 

Write point table dwell time (RAM) PT5R 01 – PT5R FF PT5R 01 – PT5R FF  

Write point table auxiliary function (EEPROM) PTB6 01 – PTB6 FF PTB6 01 – PTB6 FF  
64 CB 

Write point table auxiliary function (RAM) PT6R 01 – PT6R FF PT6R 01 – PT6R FF  

Absolute position of servo motor end pulse unit ETC 90 –––––  
02 – 

Command unit absolute position ETC 91 –––––  

*Note 1) 00 – 11 Address area not supported 

*Note 2) 32 bit device 


